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Sikkerhed og fejlfinding

Sikkerhedsforanstaltninger og
vedligeholdelse

Hyppigt stillede spargsmal
Fejlfinding

Lovmaessige oplysninger

Oplysninger om sikkerhed og fejlfinding

Sikkerhedsforanstaltninger og vedligeholdelse

fremgangsmader, der ikke er beskrevet i denne dokumentation, kan

2 ADVARSEL: Anvendelse af kontrolelementer, justeringer eller
resultere i elektrisk stad, elektriske ulykker og/eller mekaniske ulykker.

Lees og falg disse vejledninger, nar du tilslutter og anvender din computerskaerm:
Betjening:

e Hold skaermen veek fra direkte sollys og vaek fra braeendeovne og andre varmekilder.

e Fjern alt, der kan risikere at falde i ventilationshullerne eller forhindre korrekt afkaling af
skeermens elektronik.

e Bloker ikke ventilationshullerne pa kabinettet.

e Ved placering af skeermen skal du sikre dig, at det er let at komme til stramstikket og
stikkontakten.

e Huvis der slukkes for skeermen ved at fijerne stramkablet eller jaevnstrgmsledningen, skal du
vente 6 sekunder, fgr du szetter stramkablet eller jeevnstrgmsledningen til igen for at opna
normal betjening.

e Brug altid et godkendt stramkabel, der er leveret af Philips. Hvis du mangler dit stramkabel,
skal du kontakte dit lokale servicecenter. (Se Informationscenter for kundepleje)

e Udseet ikke LCD-skaermen for sveere rystelser eller slag under brug.

e Sla ikke pa skeermen, og tab den ikke under brug eller transport.

Vedligeholdelse:

e For at beskytte din skaerm mod risiko for beskadigelse, ma du ikke trykke pa LCD-skeermen.
Nar du flytter din skaerm, sa tag fat om rammen for at lgfte den; laft ikke skeermen ved at
seette din hand eller fingre pa LCD-skaermen.

e Tag stikket ud fra skeermen, hvis du ikke skal bruge den i en laengere periode.

e Tag stikket ud at kontakten til skeermen, hvis du skal renggre den med en let fugtet klud.
Skeermen kan tarres af med en tar klud, nar der er slukket for strammen. Under alle
omsteendigheder, ma der ikke bruges organiske oplagsningsmidler til renggring af din skeerm.

e For at undga risiko for elektrisk stad eller permant beskadigelse af anlaegget, s& ma du ikke
udseette skaermen for stav, regn, vand eller miljger med hgj fugtighed.

e Hvis din skeem bliver vad, skal den tarres af med en tar klud s hurtigt som muligt.

e Huvis der kommer fremmed substans eller vand ind i skaermen, sa sluk straks for strammen
og tag stikker ud. Fjern derefter den fremmede substans eller vandet, og send skeermen til
servicecenteret.
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Sikkerhed og fejlfinding

e Opbevar og brug ikke LCD-skeermen pa steder, der er udsat for varme, direkte sollys eller
ekstrem kulde.
e For at opretholde den bedste ydelse af din skaerm og for langvarig brug, sa brug skeermen et
sted, der er indenfor fglgende temperatur- og fugtighedsomrade.
o Temperatur: 0-40°C 32-95°F
o Fugtighed: 20-80% RH
e VIGTIGT: Sarg altid for at aktivere en pauseskaerm, der bevaeger sig, nar skeermen
efterlades uden at blive anvendt. Sgrg altid for at aktivere et program, der opdaterer
skaermbilledet regelmaessig, hvis LCD-skaermen viser indhold, der ikke skifter. Uafbrudt
visning af stille eller statiske billeder over en leengere periode kan forarsage, at det “braendes
fast” pa skeermen, dvs. de sakaldte “spggelsesbilleder” pa din skeerm. "Fastbraending” og
"spggelsesbilleder” er velkendte faenomener inden for LCD-skeermteknologien.
“Fastbreending” og “spggelsesbilleder” forsvinder oftest gradvist efter en vis periode, efter
skaermen er slukket.

ADVARSEL: Imidlertid forsvinder alvorligere tilfeelde af “fastbraending” og
“spggelsesbilleder” ikke og kan ej heller fiernes ved reparation. Ovennaevnte skader
er ikke daekket af garantien.

Service:

e Kabinettet ma kun &bnes af kvalificeret servicepersonale.
e Hvis der er behov for et dokument til reparation eller integration, sa kontakt dit lokale

servicecenter. (Se kapitel om "Kundeinformationscenter")

e For transportinformation, se "Fysiske specifikationer".
e Efterlad ikke din skeerm i en bil/lbagagerum under direkte sollys.

pa, hvad du skal gare, nar betjeningsinstruktionerne, der er givet i denne manual, er

E Kontakt en servicetekniker, hvis skaermen ikke fungerer korrekt, eller hvis du er usikker
fulgt.

TILBAGE TIL TOPPEN AF SIDEN
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Hyppigt Stillede Sp @ rgsmal (FAQ)

Sikkerhed og Fejlfinding Hyppigt Stillede Spagrgsmal (FAQ)

Generelle FAQ

Kompatibilitet med andre
perifere enheder Generelle FAQ
LCD Skaerm Teknologi
SP1:Hvad skal jeg gare, hvis skeermen under installationen viser "Cannot display this video

Ergonomi, @kologi og mode" ("Kan ikke vise denne videotilstand')?

Sikkerhedsstandarder

Fejlfinding SV: Den anbefalede oplgsning for Philips 22" er: 1680 x 1050 @60Hz.

Lovmaessig information
1. Frakobl alle kabler og forbind derefter pc'en til skeermen, som du brugte far.

2. 1 Windows Start Menu, veelg Indstillinger/Kontrolpanel. | Kontrolpanel vinduet
veelg Skeerm-ikonen. | Egenskaber for Skeerm vinduet veelg "Indstillinger"”
fanebladet. Under indstillinger, skub skyderen til 1680 x 1050 pixler (22").

3. Abn "Avanceret" og indstil opdateringshastigheden p& 60Hz og klik derefter pa
OK.

4. Genstart computeren og gentag trinene 2 og 3 for at bekreefte, at pc'en er
indstillet pa 1680 x 1050@60Hz (22").

5. Luk for computeren, frakobl den gamle skaerm og genforbind Philips LCD
skeermen.

6. Teend for skeermen og derefter for pc'en.

SP2:Hvad ggr den anbefalede opdateringshastighed for LCD skaermen?

SV:Den anbefalede opdateringshastighed for LCD skeerme er 60Hz. | tilfeelde af
forstyrrelser p& skaermen skal du seette den op til 75Hz og se, om dette fierner
forstyrrelserne.

SP3:Hvad er .inf og .icm filerne pa cd-rom'en? Hvordan installerer jeg driverne (.inf og .icm)?

SV: Dette er skeermens driverfiler. Installer driverne i henhold til brugervejledningens
anvisninger. Computeren kan bede dig om skaermdrivere (.inf og .icm filer) eller om
en driverdisk, nar du installerer skeermen fgrste gang. Indsaet (medfaglgende cd-rom) i
pakken i henhold til anvisningerne. Skeermdrivere (.inf og .icm filer) installeres
automatisk.
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Hyppigt Stillede Sp @ rgsmal (FAQ)
SP4:Hvordan justerer jeg oplgsningen?
SV: Skeermkortet/grafikdriveren og skeermen bestemmer sammen oplgsningerne til

radighed. Du kan veelge den gnskede oplgsning "Egenskaber for Skaerm" i
Windows® kontrolpanelet.

SP5:Hvad, hvis jeg "farer vild", mens jeg justerer skeermen?

SV:Sa skal du blot trykke pa OK og derefter vaelge "Reset" ("Tilbagestil") for at ga
tilbage til de oprindelige fabriksindstillinger.

SPG6:Er LCD skaermen modstandsdygtig over for skrammer og ridser?

SV: Det anbefales generelt ikke at udseette skaermens overflade for kraftige stad.
Den er beskyttet mod skarpe og stumpe ting. Nar du handterer skeermen sa pas pa
ikke at trykke for kraftigt pa skeermens overflade. Det kan pavirke
garantibetingelserne.

SP7:Hvordan renggr jeg LCD skaermens overflade?

SV:Til normal rengaring skal du blot anvende en ren, blgd klud. Til kraftigere
rengering skal du bruge isopropylalkohol. Brug ikke andre oplgsningsmidler sdsom

ethylalkohol, ethanol, acetone, hexan osv.

SP8:Kan jeg andre skeermens farveindstilling?
SV:Ja, du kan eendre farveindstillingen via OSD pa falgende made:

1. Tryk pa "OK" for at se OSD (skaerm-) menuen
2. Tryk pa "Nedpil" for at vaelge "Color" ("Farve") og tryk derefter pa "OK" for at abne

farveindstillingen. Der er tre indstillinger:

a. Color Temperature (Farvetemperatur) - de seks indstillinger er 5000K,
6500K, 7500K, 8200K, 9300K og 11500K. Med indstillinger i 5.000K omradet
virker skeermen "varm" med en ragd-hvid farvetone, mens en 11.500K
temperatur giver en "kold" bl&-hvid toning.
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Hyppigt Stillede Sp @ rgsmal (FAQ)

b. SRGB - dette er en standardindstilling, som sikrer korrekt udveksling af
farver mellem forskellige enheder (f.eks. digitale kameraer, skeerme printere,
skannere 0sv.)

c. Brugerdefiner - brugeren kan vaelge sin foretrukne farveindstilling ved at
indstille den rade, grgnne og bla farve.

*Et mal for farven pa lys, der udstrales fra et objekt, mens det opvarmes. Dette mal
udtrykkes p& en absolut skala (kelvingrader). Lavere kelvingrader sdsom 2.004K er
rade, hgjere temperaturer sdsom 9.300K er bl&. Neutral temperatur, 6.504K, er hvid.

SP9:Kan Philips LCD skaermen monteres pa vaeggen?

SV:Ja. Philips LCD skeerme har denne ekstra egenskab. Standard VESA
monteringshullerne pa bagsiden tillader montering af Philips skeermen péa de fleste
VESA standardarme og -tilbehgr. Vi anbefaler, at du kontakter Philips

salgsrepraesentant for yderligere oplysninger.

TILBAGE TIL TOPPEN

Kompatibilitet med andre perifere enheder
SP10:Kan jeg forbinde min LCD skaerm til enhver pc, arbejdsstation eller Mac?

SV:Ja. Alle Philips LCD skaerme er fuldt kompatible med standard pc'er, Mac'er og
arbejdsstationer. En ledningsadapter kan veere ngdvendig for at kunne forbinde
skaermen til dit Mac-system. Vi anbefaler, at du kontakter Philips salgsrepreesentant

for yderligere oplysninger.

SP11:Er Philips LCD skeerme "Plug & Play"?

SV:Ja, skaermene er "Plug & Play" kompatible med Windows® 95, 98, 2000, XP,
Vista og Linux.

TILBAGE TIL TOPPEN
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Hyppigt Stillede Sp @ rgsmal (FAQ)

LCD Skeerm Teknologi
SP12:Hvilken slags bredvinkel-teknologi er til radighed?

SV:Sammenlignet med MVA og PVA teknologierne tilbyder IPS skeermene i
gjeblikket det bedste kontrastforhold. TN skaerme er blevet bedre gennem arene,
men kan stadig ikke male sig med IPS skeermenes kontrastforhold.

TILBAGE TIL TOPPEN

Ergonomi, @kologi og Sikkerhedsstandarder

SP13: Hvad er "billedkleebning” eller "billedindbraending” eller "efterbillede" eller
"spagelsesbillede” p& LCD skaerme?

SV: Uafbrudte still-billeder eller statiske billeder over en laengere periode kan
forarsage "indbreending", ogséa kaldet "efterbillede" eller "spagelsesbillede”, pa
skeermen. "Indbraending", "efterbillede" eller "spggelsesbillede" er velkendte
feenomener indenfor LCD skeerm terminologien. | de fleste tilfeelde forsvinder
"indbraending” eller "efterbillede” eller "spggelsesbillede” gradvist, efter at strammen
er slaet fra.

Aktiver altid en bevaegende pauseskaerm, nar du efterlader skaermen, uden at den
bliver brugt.

Aktiver altid et periodisk skeermopdateringsprogram, hvis LCD skaermen skal vise
statisk indhold.

ADVARSEL: Alvorlig "indbraending”- eller "efterbillede"- eller "spggelsesbillede™-
symptomer forsvinder ikke og kan ikke repareres. Ovennaevnte skade er ikke
deekket af garantien.

SP14: Hvorfor viser skaermen ikke skarp tekst? Hvorfor viser den forrevne tegn?

SV: LCD skeermen arbejder bedst med sin native oplgsning pa 1680 x 1050@60Hz.
Brug denne oplgsning for at opna det bedste billede.

TILBAGE TIL TOPPEN
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Fejlfinding

Sikkerhed og Fejlfinding

Hyppigt Stillede
Spgrgsmal
Almindelige Problemer
Billeddannelses-

problemer
Lovmaessig Information

Fejlfinding

Denne side omhandler problemer, som kan klares af brugeren selv. Hvis problemet stadig er der, efter at du har pravet
disse lgsninger, skal du kontakte Philips's Kundeservice.

Almindelige problemer

’Har dette problem

Tjek disse punkter

Billedet er ikke centreret

e Kontroller, at el-ledningen er anbragt i stikkontakten og bag
Kk billed pa skeermen.
€ ”Og_et iede . e Kontroller farst, at stramkontakten foran pa skeermen er i OFF
(Stremdiode lyser ikke) (FRA) position og tryk den derefter i ON (TIL) position.
e Kontroller, at der er teendt for computeren.
Ikke noget billede e Kontroller, at signalkablet er korrekt forbundet til computeren.
e kontroller, at der ikke er nogen bgjede stikben i signalkablets
. . ) tilslutningsende. Hvis der er det, skal du fa kablet repareret
(Stremdiode blinker hvidt) eller udskiftet.
e Energisparefunktionen kan vaere aktiveret
Skeerm siger
e Kontroller, at signalkablet er korrekt forbundet til computeren.
ATTENTION (Se ogsa quick-installationsvejledningen).
e Tjek, om skaermkablets stikben er bgjede.
CHECK CABLE CONNECTION e Kontroller, at der er teendt for computeren.
o Atomatisk-funktionen kan kun anvendes i VGA analog
tilstand. Hvis resultatet ikke er tilfredsstillende, kan der
AUTO (AUTOM.) knappen fungerer ikke foretages manuelle justeringer via OSD menuen. Bemaerk
i VGA tilstand venligst, at Automatisk-funktionen ikke virker i DVI digital
tilstand, da den ikke er ngdvendig her.
Billeddannelses-problemer
e Tryk pa Autom. knappen.
e Juster billedpositionen med Phase/Clock (Fase/Klokke) i USD

hovedmenuen.
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Fejlfinding

Billede vibrerer pa skeermen

Tjek, at signalkablet er korrekt forbundet til grafikkortet eller
pcen.

Lodret flimren

Tryk p& Autom. knappen.
Eliminer de lodrette bjeelker med Phase/Clock (Fase/Klokke) i

USD hovedmenuen.

Vandret flimren

&
4

W

Tryk pa Autom. knappen.
Eliminer de lodrette bjeelker med Phase/Clock (Fase/Klokke) i
USD hovedmenuen.

billedet er slgret, uklart eller for markt

Indstil kontrast og lysstyrke i OSD.

Der forbliver et "efterbillede”,
"indbraendingsbillede” eller
"spggelsesbillede”, efter at der er slukket
for stremmen.

Uafbrudte still-billeder eller statiske billeder over en laengere
periode kan forarsage "indbraending”, ogsa kaldet
"efterbillede” eller "spggelsesbillede”, pd skeermen.
"Indbreending", "efterbillede" eller "spggelsesbillede" er
velkendte feenomener indenfor LCD skaerm terminologien. |
de fleste tilfaelde forsvinder "indbraending" eller "efterbillede"
eller "spggelsesbillede” gradvist, efter at strammen er slaet
fra.

Aktiver altid en bevaegende pauseskaerm, nar du efterlader
skeermen, uden at den bliver brugt.

Aktiver altid et periodisk skeermopdateringsprogram, hvis LCD
skeermen skal vise statisk indhold.

Billedet er forvreenget. Tekst er utydelig
eller slgret.

Indstil pc'ens skaermoplgsning som skeermens anbefalede,
native oplgsning.

Der ses rgde, bla, mgrke og hvide
pletter pa skeermen

De tilbageveerende pletter er normale for den flydende-
krystaller-teknologi, der anvendes i dag, Se venligst pixel-

politikken for yderligere oplysninger.
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Fejlfinding

e '"Taendt" lyset kan justeres med Strgmdiode under Installation
i OSD hovedmenuen.

"Teendt" lyset er for steerkt - det
forstyrrer mig.

For yderligere hjeelp, se venligst Forbruger-informationscentre-listen og kontakt Philips's Kundeservice.

TILBAGE TIL TOPPEN
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Regulatory Information

TCO'03 Information

Recycling Information for Customers
Waste Electrical and Electronic
Equipment-WEEE

CE Declaration of Conformity

Energy Star Declaration

Federal Communications
Commission (FCC) Notice (U.S.
Only)

FCC Declaration of Conformity
Commission Federale de la
Communication (FCC Declaration)
EN 55022 Compliance (Czech
Republic Only)

Polish Center for Testing and
Certification Notice

North Europe (Nordic Countries)
Information

BSMI Notice (Taiwan Only)
Ergonomie Hinweis (nur
Deutschland)

Philips End-of-Life Disposal
China RoHS

Lead-free Product
Troubleshooting

Frequently Asked Questions (FAQS)

Regulatory Information

Available for selective models

TCO'03 Information

m Congratulations!
ﬁ 3 The display you have just purchased carries the TCO'03 Displays label. This

means that your display is designed, manufactured and tested according to some
DISPLAYS

of the strictest quality and environmental requirements in the world. This makes for
m impact on our natural environment.

a high performance product, designed with the user in focus that also minimizes the

Some of the features of the TCO'03 Display requirements.
Ergonomics

e Good visual ergonomics and image quality in order to improve the working environment for the user and
to reduce sight and strain problems. Important parameters are luminance, contrast, resolution,
reflectance, colour rendition and image stability.

Energy

e Energy-saving mode after a certain time-beneficial both for the user and the environment
e Electrical safety

Emissions

e Electromagnetic fields
o Noise emissions

Ecology

e The product must be prepared for recycling and the manufacturer must have a certified environmental
management system such as EMAS or ISO 14 000
e Restrictions on
o chlorinated and brominated flame retardants and polymers
o heavy metals such as cadmium, mercury and lead.

The requirements included in this label have been developed by TCO Development in co-operation with
scientists, experts, users as well as manufacturers all over the world. Since the end of the 1980s TCO has
been involved in influencing the development of IT equipment in a more user-friendly direction. Our labelling
system started with displays in 1992 and is now requested by users and IT-manufacturers all over the world.

For more information, please visit
www.tcodevelopment.com

RETURN TO TOP OF THE PAGE
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Regulatory Information

Recycling Information for Customers

There is currently a system of recycling up and running in the European countries, such as The Netherlands,
Belgium, Norway, Sweden and Denmark.

In Asia Pacific, Taiwan, the products can be taken back by Environment Protection Administration (EPA) to
follow the IT product recycling management process, detail can be found in web site www.epa.gov.tw

The monitor contains parts that could cause damage to the nature environment. Therefore, it is vital that the monitor is
recycled at the end of its life cycle.

For help and service, please contact Consumers Information Center or F1rst Choice Contact Information
Center in each country.

RETURN TO TOP OF THE PAGE

Waste Electrical and Electronic Equipment-WEEE

Attention users in European Union private households

This marking on the product or on its packaging illustrates that, under European Directive
2002/96/EC governing used electrical and electronic appliances, this product may not be disposed of with
normal household waste. You are responsible for disposal of this equipment through a designated waste
electrical and electronic equipment collection. To determine the locations for dropping off such waste electrical
and electronic, contact your local government office, the waste disposal organization that serves your
household or the store at which you purchased the product.

Attention users in United States:
Like all LCD products, this set contains a lamp with Mercury. Please dispose of according to all Local, State
and Federal laws. For the disposal or recyciing information, contact www.mygreenelectronics.com or www.eiae.

org.

RETURN TO TOP OF THE PAGE
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Regulatory Information

EPEAT

“The EPEAT (Electronic Product Environmental Assessment Tool) program evaluates computer desktops,
laptops, and monitors based on 51 environmental criteria developed through an extensive stakeholder
consensus process supported by US EPA.

EPEAT system helps purchasers in the public and private sectors evaluate, compare and select desktop
computers, notebooks and monitors based on their environmental attributes. EPEAT also provides a clear and
consistent set of performance criteria for the design of products, and provides an opportunity for manufacturers
to secure market recognition for efforts to reduce the environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S requirement that all registered products meet ENERGY
STAR'’s energy efficiency specifications, means that these products will consume less energy throughout their
life.

RETURN TO TOP OF THE PAGE

ROHS is a European Directive aiming to control the use of certain hazardous substances in the production of
new electrical and electronic equipment. Philips has completely eliminated four of six RoHS-banned
substances form its products by 1998-eight full years before compliance was required and has lowered usage
of the remaining substances significantly below the mandated levels.

RETURN TO TOP OF THE PAGE

CE Declaration of Conformity

This product is in conformity with the following standards

- EN60950-1:2001 (Safety requirement of Information Technology Equipment)

- EN55022:2006 (Radio Disturbance requirement of Information Technology Equipment)
- EN55024:1998 (Immunity requirement of Information Technology Equipment)

- EN61000-3-2:2006 (Limits for Harmonic Current Emission)

- EN61000-3-3:1995 (Limitation of Voltage Fluctuation and Flicker)

following provisions of directives applicable

- 2006/95/EC (Low Voltage Directive)

- 2004/108/EC (EMC Directive)

and is produced by a manufacturing organization on 1SO9000 level.

The product also comply with the following standards

- 1SO13406-2 (Ergonomic requirement for Flat Panel Display)

- GS EK1-2000 (GS specification)

- prEN50279:1998 (Low Frequency Electric and Magnetic fields for Visual Display)

- MPR-1I (MPR:1990:8/1990:10 Low Frequency Electric and Magnetic fields)

- TCO'03, TCO Displays 5.0 (Requirement for Environment Labelling of Ergonomics, Energy, Ecology and
Emission, TCO: Swedish Confederation of Professional Employees) for TCO versions

RETURN TO TOP OF THE PAGE
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Regulatory Information

Energy Star Declaration

This monitor is equipped with a function for saving energy which supports the VESA Display
Power Management Signaling (DPMS) standard. This means that the monitor must be

connected to a computer which supports VESA DPMS. Time settings are adjusted from the
system unit by software.

VESA State LED Indicator Power Consumption
Normal operation ON (Active) White <20 W (typ.)
Power Saving
Alternative 2 . o
One step Sleep White Blinking <0.5W (typ.)
Switch Off Off <0.5W (typ.)

As an ENERGY STAR® Partner, we have determined that this product meets the
ENERGY STAR® guidelines for energy efficiency.

We recommend you switch off the monitor when it is not in use for a long time.

A

RETURN TO TOP OF THE PAGE

Federal Communications Commission (FCC) Notice (U.S. Only)

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

B>

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

>

Use only RF shielded cable that was supplied with the monitor when connecting this monitor to a computer
device.
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Regulatory Information

To prevent damage which may result in fire or shock hazard, do not expose this appliance to rain or excessive
moisture.

THIS CLASS B DIGITAL APPARATUS MEETS ALL REQUIREMENTS OF THE CANADIAN INTERFERENCE-
CAUSING EQUIPMENT REGULATIONS.

RETURN TO TOP OF THE PAGE

FCC Declaration of Conformity

Declaration of Conformity for Products Marked with FCC Logo,

United States Only

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

RETURN TO TOP OF THE PAGE

Commission Federale de la Communication (FCC Declaration)

Cet équipement a été testé et déclaré conforme auxlimites des appareils numériques de
class B,aux termes de l'article 15 Des regles de la FCC. Ces limites sont congues de fagon
a fourir une protection raisonnable contre les interférences nuisibles dans le cadre d'une

@ installation résidentielle. CET appareil produit, utilise et peut émettre des hyperfréquences
qui, si I'appareil n'est pas installé et utilisé selon les consignes données, peuvent causer
des interférences nuisibles aux communications radio. Cependant, rien ne peut garantir
I'absence d'interférences dans le cadre d'une installation particuliére. Si cet appareil est la
cause d'interférences nuisibles pour la réception des signaux de radio ou de télévision, ce
qui peut étre décelé en fermant I'équipement, puis en le remettant en fonction, l'utilisateur
pourrait essayer de corriger la situation en prenant les mesures suivantes:

Réorienter ou déplacer I'antenne de réception.

Augmenter la distance entre I'équipement et le récepteur.

Brancher I'équipement sur un autre circuit que celui utilisé par le récepteur.
Demander l'aide du marchand ou d'un technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas regu |'approbation des services compétents en matiére de
conformité est susceptible d'interdire a I'utilisateur l'usage du présent équipement.

N'utiliser que des cables RF armés pour les connections avec des ordinateurs ou périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE B RESPECTE TOUTES LES EXIGENCES DU REGLEMENT
SUR LE MATERIEL BROUILLEUR DU CANADA.
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Regulatory Information

RETURN TO TOP OF THE PAGE

EN 55022 Compliance (Czech Republic Only)

This dewica belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A davice on tha spscification labal. The following applias to
davices in Class A of EN 55022 (redius of profection up to 30 maters). Tha ussr of tha
davice is obliged 1o tske all stapa necessary to remove sources of interfansnce o tals-
communication or ofhar devicas.

Pokud nenf na typovam Btk podftate uvedeno, £a spadé do do ffidy A podis EN 55022,
spadi automaticky do Hidy B podle EN 55022, Pro zafizen! zalazend do tidy A (chranné
pésmo 30m) podle EN 85022 platl nésledulici. Dojde-li k rudenl talekomunikainich nebo
finjch zafizeni je ufivatel povinnen prowést takovd opatign, aby neSeni odstranil,

RETURN TO TOP OF THE PAGE

Polish Center for Testing and Certification Notice

The equipment should draw power from a socket with an attached protection circuit (a three-prong socket). All
equipment that works together (computer, monitor, printer, and so on) should have the same power supply
source.

The phasing conductor of the room's electrical installation should have a reserve short-circuit protection device
in the form of a fuse with a nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the power supply cable must be removed from the power supply
socket, which should be located near the equipment and easily accessible.

A protection mark "B" confirms that the equipment is in compliance with the protection usage requirements of
standards PN-93/T-42107 and PN-89/E-06251.
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Regulatory Information

Wymagania Polskiego Centrum Badan i Certyfikacji
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RETURN TO TOP OF THE PAGE

North Europe (Nordic Countries) Information

Placering/Ventilation
VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation
ADVARSEL:

SORG VED PLACERINGEN FOR, AT NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto
VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.
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Regulatory Information

Plassering/Ventilasjon
ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA DU PASSE PA AT KONTAKTENE FOR
STOMTILFGRSEL ER LETTE A NA.

RETURN TO TOP OF THE PAGE

BSMI Notice (Taiwan Only)

HEelAENERZEE

RETURN TO TOP OF THE PAGE

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den in der "Verordnung tber den Schutz vor Schaden durch
Rontgenstrahlen” festgelegten Vorschriften.

Auf der Rickwand des Gerates befindet sich ein Aufkleber, der auf die Unbedenklichkeit der Inbetriebnahme
hinweist, da die Vorschriften tiber die Bauart von Stérstrahlern nach Anlage Ill @ 5 Abs. 4 der
Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung geforderten Werten entspricht, ist darauf zu achten, daR
1. Reparaturen nur durch Fachpersonal durchgefiihrt werden.

2. nur original-Ersatzteile verwendet werden.
3. bei Ersatz der Bildrohre nur eine bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen, die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit und erhéhte Augenbelastung bei zu geringem
Zeichenkontrast waren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach DIN 45 635 betragt 70dB (A) oder weniger.

ACHTUNG: BEIM AUFSTELLEN DIESES GERATES DARAUF ACHTEN, DAR
NETZSTECKER UND NETZKABELANSCHLUR LEICHT ZUGANGLICH SIND.

RETURN TO TOP OF THE PAGE

End-of-Life Disposal
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Regulatory Information

Your new monitor contains materials that can be recycled and reused. Specialized companies can recycle your
product to increase the amount of reusable materials and to minimize the amount to be disposed of.

Please find out about the local regulations on how to dispose of your old monitor from your sales
representative.

(For customers in Canada and U.S.A))
This product may contain lead and/or mercury. Dispose of in accordance to local-state and federal regulations.
For additional information on recycling contact www.eia.org (Consumer Education Initiative)

RETURN TO TOP OF THE PAGE

China RoHS

The People's Republic of China released a regulation called "Management Methods for Controlling Pollution by
Electronic Information Products" or commonly referred to as China RoHS. All products including CRT and LCD
monitor which are produced and sold for China market have to meet China RoHS request.
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http://www.eia.org/

Regulatory Information
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RETURN TO TOP OF THE PAGE

Lead-free Product

Lead free display promotes environmentally sound recovery and disposal of waste from
electrical and electronic equipment. Toxic substances like Lead has been eliminated and
compliance with European community’s stringent RoHs directive mandating restrictions on
hazardous substances in electrical and electronic equipment have been adhered to in order to
make Philips monitors safe to use throughout its life cycle.

RETURN TO TOP OF THE PAGE
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Om denne elektroniske brugervejledning

Om denne vejledning

Notationsbeskrivelser

Om denne brugsanvisning

Om denne vejledning

Denne elektroniske brugervejledning er beregnet til alle, der anvender en Philips LCD-skeerm. Den
beskriver LCD-skaermens funktioner, opsaetning, betjening og andre vigtige oplysninger. Indholdet
er identisk med oplysningerne i vores trykte vejledning.

Hjeelpen indeholder falgende afsnit:

Oplysninger om sikkerhed og fejlfinding indeholder tips og Igsninger til almindelige
problemer og andre relevante oplysninger.

Om denne elektroniske brugervejledning giver en oversigt over oplysningerne samt
beskrivelser af ikoner til noter og anden dokumentation, du skal bruge.

Produktoplysninger giver en oversigt over skaermens funktioner og de tekniske
specifikationer for denne skeerm.

Installering af skeermen beskriver opsaetningen i starten og giver en oversigt over, hvordan
skeermen anvendes.

OSD (On Screen Display) indeholder oplysninger om justeringen af skeermens indstilllinger.

Kundeservice og garanti er en liste med Philips forbrugeroplysningscentre sammen med

Help desk-telefonnumre og oplysninger om den garanti, der deekker produktet.
Ordliste definerer tekniske termer.
Indstillingen Download and Print (Download og Print) overfgrer hele handbogen til

harddisken til hurtige opslag.

TILBAGE TIL TOPPEN AF SIDEN

Notationsbeskrivelser
Falgende underafsnit beskriver de notationsmaessige konventioner, der benyttes i dette dokument.

Bemeerkninger, forsigtighedsregler og advarsler
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Om denne elektroniske brugervejledning
I hele denne vejledning kan tekstblokke veere ledsaget af et ikon og std med fed eller kursiv skrift.
Disse blokke indeholder bemaerkninger og punkter, hvor der skal udvises forsigtighed, eller
advarsler. De anvendes som fglger:

BEM/AERK: Dette ikon angiver vigtige oplysninger og tips, hvormed du kan
gere bedre brug af computersystemet.

FORSIGTIG: Dette ikon angiver oplysninger om, hvordan du undgar risiko for
skader pa hardwaren eller tab af data.

ADVARSEL: Dette ikon angiver risiko for personskader og hvordan dette
undgas.

> b

Visse advarsler kan optreede i andre formater og er eventuelt ikke ledsaget af et ikon. | sddanne
tilfeelde er den givne udformning af advarslen lovmaessigt obligatorisk.

TILBAGE TIL TOPPEN AF SIDEN
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Produktinformation

LCD skeermen

PowerSensor Produktinformation

Smart-billede

Smart-kontrast LCD skaermen

S e Tillykke med anskaffelsen og velkommen til Philips. For fuldt ud at kunne udnytte statten fra Philips, skal du registrere
Smart-skarphed dit produkt pa: www.philips.com/welcome

Tekniske specifikationer

Oplgsning og forvalgte
indstillinger

Philips's politik vedrgrende
defekte pixler

Automatisk energispare

PowerSensor
Hvad er “PowerSensor”?

“PowerSensor” er en unik, mgjvenlig teknologi fra Philips, som ggr det muligt at spare op til 70% af energiforbruget. Den
Produktoversigter er meget brugervenlig og kraever ingen software installation for at kunne bruges. Den fungerer i henhold

. . til standardindstillinger og sparer derved energi og penge.
Fysisk funktion

Smart-kontrol I Bruger til stede foran skeermen Bruger ikke til stede foran skeermen

Ovenstaende strgmforbrug tiener kun til illustration.
Hvordan fungerer det?

1 PowerSensor fungerer ved afsendelse og modtagelse af uskadelige, “infrarade” signaler for at registrere brugerens
tilstedeveerelse.

o Nar brugeren sidder foran skaermen, fungerer denne normalt med hensyn til brugerens forindstillinger, dvs. lysstyrke, kontrast,

farve osv.

Hvis det forudseettes, at skaermen f.eks. er indstillet p& 100% lysstyrke, s& deempes skaermen ned til 30% lysstyrke, hvis brugeren

rejser sig fra stolen og ikke lsengere sidder foran skeermen.

o

Hvad er fordelene?

o Nedseettelse af lysstyrken, 50% til 70% strgmbesparelse
o Nedseettelse af virksomhedens totale ejerskabsudgifter
o “Gregn” ydelse, miljgvenlig drift
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Produktinformation

s Forleengelse af skeermens levetid med deraf falgende lavere totale ejerskabsudgifter
PowerSensor indstillinger
Standardindstillinger

Ved standardindstillingen, Indstilling 3 er PowerSensor konstrueret til at registrere brugeren mellem 30cm og 100cm
fra skeermen og indenfor fem grader til venstre og hgjre for skeermen.

Brugerindstillinger

Hvis en bruger befinder sig udenfor ovennaevnte perimetre, skal der veelges en hgjere signalstyrke for at opna
optimal effektivitet. Jo hgjere indstilling, jo hajere registreringssignal. For at opnd maksimal PowerSensor effektivitet skal
du anbringe dig lige foran skeermen.

o Hvis du anbringer dig mere end 100cm fra skaermen, skal du bruge det maksimale registreringssignal for afstande op til 120cm.

o Da markt tgj har en tendes til at absorbere infrargde signaler, selv nar brugeren befinder sig indenfor 100cm fra skeermen, skal
signalstyrken gges, nar brugeren har merkt tgj pa.

o Du kan til hver en tid vende tilbage til standardindstillingen, nér en kortere registreringsafstand gnskes.

Sadan justeres indstillinger

Hvis PowerSensor ikke fungerer korrekt inden- eller udenfor standardafstanden, kan du finindstille registreringen
pa falgende made:

o Tryk p& PowerSensor genvejstasten

s Standardpositionen “3” ses pa justeringsbjeelken.

o Indstil PowerSensor registreringen pa Indstilling 4 og tryk pa OK.

o Test den nye indstilling for at kontrolere, at du registreres af PowerSensor i din nuvaerende position.

Bemeerk:
En manuelt valgt PowerSensor indstilling forbliver aktiv, indtil enheden genindstilles eller standard-indstillingen genkaldes.
Hvis PowerSensor er overfalsom overfor beveegelser i neerheden, skal du prgve dig frem med en lavere signalstyrke.

Genvejstast Sensorafstand

PowerSensor detection adjusiment

A —
3 (default)

TILBAGE TIL TOPPEN
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Produktinformation

Smart-billede

Hvad er dette?

Smart-billede er forvalgte indstillinger, der optimerer skaermen i henhold til indholdet, og som realtid dynamisk

indstiller lysstyrke, kontrast, farve og skarphed. Uanset om du arbejder med tekstprogrammer, ser billeder eller ser video,
sa giver Philips Smart-billede den optimale LCD skeermydelse..

Hvorfor behgver jeg det?

Du gnsker en LCD skaerm, som giver det bedste billede ved alle typer indhold. For at gge LCD oplevelsen, indstiller
Smart-billede softwaret realtid og dynamisk lysstyrke, kontrast, farve og skarphed.

Hvordan virker det?
Smart-billede er en eksklusiv, farende Philips-teknologi, som analyserer indholdet pa skaermen. Ud fra det valgte
scenarie forbedrer Smart-billede dynamisk billeders og videoers kontrast, farvemaethed og skarphed for at opna

det ultimative billede - alt i realtid og blot med et tryk pa en knap.

Hvordan aktiveres Smart-billede?

Tryk pa @7 for at starte Smart-billede pa skeermen;

2. Fortsaet med at trykke p& @7 for at skifte mellem Office Work (Kontorarbejde), Image Viewing
(Billedvisning), Entertainment (Underholdning), Economy (dkonomi) og Off (Fra);
3. Smart-billede ses pa skeermen i fem sekunder, men du kan ogsa trykke pa OK for at bekreefte.

4. Nar Smart-billede er aktiveret, deaktiveres SRGB systemet automatisk. For at bruge sSRGB skal du
deaktivere Smart-billede med @7 foran pa skeermen.
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Produktinformation

Udover at bruge @7 til at rulle ned med, kan du ogsa trykke pa WA forat veelge og derefter trykke pa OK for at
bekraefte valget og derefter igen lukke Smart-billede OSD. Der kan vaelges mellem fem tilstande: Office
Work (Kontorarbejde), Image Viewing (Billedvisning), Entertainment (Underholdning), Economy (@konomi) og Off (Fra).

Der kan veelges mellem fem tilstande: Office Work (Kontorarbejde), Image Viewing (Billedvisning), Entertainment
(Underholdning), Economy (@konomi) og Off (Fra).

B Smart Image

Office Work

1. Office Work (Kontorarbejde): Forbedrer teksten og deemper lysstyrken for at gge laesbarheden og nedsaette
anstrengelsen af gjnene. Denne tilstand gger afggrende leesbarheden og produktiviteten, nar der arbejdes med regneark,
PDF filer, skannede artikler og andre generelle kontorprogrammer.

2. Image Viewing (Billedvisning): Denne profil kombinerer farvemaethed og dynamisk kontrast og skarphed for at vise
billeder og lignende overordentlig klart og i levende farver - alt uden synlige fejl i det indskannede billede og blegnede
farver.

3. Entertainment (Underholdning): Viser hver detalje i videoernes mgrkere omrader med gget luminans, dyb
farvemeethed, dynamisk kontrast og barberbladsagtig skarphed og uden farveudvaskning i de lysere omrader og opnar
pa denne made dynamiske, naturlige veerdier med henblik pa den ultimative videovisning.

4. Economy (@konomi): Med denne profil indstilles lysstyrke og kontrast, ligesom baggrundslys fintunes for at opna det
rette billede til hverdagens kontorprogrammer. Nedsat strgmforbrug.

5. Off (Fra): Ingen optimering med Smart-billede

TILBAGE TIL TOPPEN

Smartkontrast
Hvad er dette?
Unik teknologi, der dynamisk analyserer det viste indhold og automatisk optimerer LCD skaermens kontrastforhold

til maksimal visuel klarhed. Den gger baggrundsbelysningen og giver et klarere, friskere og lysere billede eller
deemper baggrundsbelysningen med henblik p& en tydelig visning af billeder pd mark baggrund.
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Hvorfor behgver jeg det?

Du gnsker den allerbedste visuelle klarhed og visning ved enhver type indhold. Smart-kontrast styrer dynamisk kontrast
og indstiller baggrundslyset, s& det giver klare, friske og lyse spil- og videobilleder og viser tydelig, leesbar tekst

ved kontorarbejde. Ved at nedsaette skeermens strgmforbrug, sparer du energiomkostninger og forleenger skaermens levetid.
Hvordan virker det?

Nar du aktiverer Smart-kontrast, analyserer denne realtid det viste indhold for at indstille farver og baggrundslysets
intensitet. Denne funktion kan helt klart forbedre kontrasten dynamisk for at opna mere underholdning og sjov, nar du
ser videoer og spiller spil.

TILBAGE TIL TOPPEN

Smart-farvemeethed
Hvad er dette?

Smart-teknologien, der styrer farvemeethed - dvs. graden, med hvilken skaermfarverne udtyndes med nabofarverne -
giver rige og livlige billeder for at opna mere underholdning og sjov, nar du ser videoer.

Hvorfor behgver jeg det?
Du gnsker rige og livlige billeder for mere underholdning og sjov, nar du ser billeder og videoer.
Hvordan virker det?

Smart-farvemeetning styrer dynamisk farvemaetningen — dvs. graden, med hvilken skeermfarverne udtyndes

med nabofarverne — for at give rige og livlige billeder for mere underholdning og sjov, nar du ser billeder og videoer
i skeermens Entertainment (Underholdning-)tilstand. Nar den er sléet fra, ydes der topkvalitetsbilleder af
kontorprogrammer, og i Economy (dkonomi-)tilstand nedsaettes stramforbruget.

TILBAGE TIL TOPPEN

Smart-skarphed
Hvad er dette?

Smart-teknologien, som gger skarpheden, né&r du behgaver den til ultimativ billedydelse og mere underholdning og sjov,
nar du ser videoer og billeder.

Hvorfor behgver jeg det?
Du gnsker den ultimative skarphed for mere underholdning og sjov, nar du ser billeder og videoer.
Hvordan virker det?

Smart-teknologien gger skarpheden, nar du behgver den til ultimativ billedydelse og mere underholdning og sjov, nar du
ser videoer og billeder i Entertainment (Underholdning-)tilstanden. Nar den er slet fra, ydes der topkvalitetsbilleder
af kontorprogrammer, og i Economy (@konomi-)tilstand nedseettes stramforbruget.

TILBAGE TIL TOPPEN
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Tekniske specifikationer*

Billede/Skaerm

LCD skeermtype ’TFT-LCD
Skeermstgrrelse ’22"W
Starrelsesforhold ’ 16:10

Pixel-pitch ]o,zsz x 0,282 mm
Lysstyrke 250 cd/m?
SmartContrast ’ 25000:1

1000:1
Reaktionstid (normal) ’5 ms

Optimal oplgsning

]1680 x 1050 @ 60Hz

|
|
|
|
|
’ Kontrastforhold (normalt)
|
|
|
|
|
|
|
|

Synsvinkel ’176° (V)/170° (L)@ C/IR>5
Billedforbedring ’Smart-billede

Skaermfarver ’16,7 M

Lodret opdateringshastighed ’56 Hz - 76 Hz

Vandret frekvens ’30 kHz - 80 kHz

SRGB | 9A

’Tilslutningsmuligheder

’ Signalindgang

’DVI-D (digital, HDCP), VGA (analog)

] USB

]USB 2,0x1

’ Indgangssignal

’Separat synk., synk. pa gran

] Lyd ind/ud ’Stereolyd
Behagelighed
’ Indbygget lyd ’1,5 W x 2

Brugerbehagelighed

Smart-billede, Autom. (tilbage), Input (ned), Lysstyrke (op), Menu (OK),
Strgm Til/Fra

OSD sprog

Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk og
portugisisk

’ Anden behagelighed

’VESA montering (100 x 100mm), kensington-las

| "Plug & Play" kompatibilitet

’DDC/CI, SRGB, Windows 98/2000/XP/Vista, Mac OS X
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Produktinformation

Fod

’ Vipning

]-5/+2o

’ Hgjdejustering

]130 mm (225P1), 70 mm (225B1)

’ Drejning

]-65/+65 (225P1), -45/+45 (225B1)

’Strfam

’ Teendt tilstand

’< 24 W (typ.), < 30 W (maks.)

Teendt tilstand (JKO-tilstand) <175W
(normalt)
AC indgangsspaending |AC indgangsspeending |AC indgangsspeaending
Energiforbrug ved 100VAC +/-5VAC, |115VAC +/-5VAC, 230VAC +/-5VAC, 50Hz
50Hz +/- 3Hz 60Hz +/- 3Hz +/ -3Hz
INormal drift 120w 20w 20w
’Sovetilstand ’0,5 W (norm.) ’0,5 W (norm.) |0,5 W (norm.)
Fra 0,5 W 0,5 W 0,5 W
AC indgangsspaending |AC indgangsspeending |AC indgangsspeaending
Varmetab* ved 100VAC +/-5VAC, |115VAC +/-5VAC, 230VAC +/-5VAC, 50Hz
50Hz +/- -3Hz 60Hz +/- -3Hz +/ -3Hz
[Normal drift 102,4BTU/ 102,4BTU/ 102,4BTU/
|Sovetilstand |2,73BTUN 2,73BTUN |2,73BTUN
Fra |1,7BTU |1,7BTU |1,7BTU
’ Stremdiode ’Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

’ Strgmforsyning

]lndbygget, 100-240VAC, 50/60Hz

]Mél

’ Produkt med fod (BxHxD)

]502 x 589 x 220 mm (225P1), 502 x 446 x 228 mm (225B1)

’ Produkt uden fod (BxHxD)

]502 X 346 x 58 mm

’ Kassemal (BxHxD)

’658 x 410 x 272 mm (225P1), 562 x 480 x 168 mm (225B1)

’Vaegt

’ Produkt med fod

]6,4 kg (225P1), 5,2 kg (225B1)

’ Produkt uden fod

]4,1 kg

’ Produkt med emballage

]7,6 kg (225P1), 6,9 kg (225B1)

’Driftsforhold

’ Temperaturomrade (drift)

0°Ctil40°C

’ Temperaturomrade (drift)

]-20° C il 60° C

’ Relativ fugtighed

]20% til 80%

Hgjde

]lkke drift: + 3.658 m

’drift: +12.192m
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Produktinformation

glc\)llc;l':?:llf1 IEtg?ce::)nemsnitstid med ’ 50.000 timer
|Mi|jﬂmaessige forhold

| ROHS IA

| EPEAT |Si|ver-k|assificerede
| EnergyStar |5.0

| Emballage |100% genbrugelig

|Overho|delse og standarder

. CE maerket, Energy Star 5.0, FCC klasse B, SEMKO, TCO 03, TUV/GS,
Regulative godkendelser

TOV Ergo, UL/cUL

|Kabinet
| Farve |Sortlsnlv, Sort/Sort
| Overfladebehandling |Struktur

* Disse data kan eendres uden meddelelse derom.

TILBAGE TIL TOPPEN

Oplgsning og forvalgte indstillinger

A. Maksimal oplgsning
- For 225P1/225B1

1680 x 1050 ved 60 Hz (analog indgang)

1680 x 1050 ved 60 Hz (digital indgang)
B. Anbefalet Oplgsning

- For 225P1/225B1
1680 x 1050 ved 60 Hz (digital indgang)

18 fabriksforvalgte tilstande:
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31,469
31,469
31,469
35,000
37,500
35,156
37,879
46,875
48,363
60,023
63,981
79,976
55,469
55,935
70,635
66,587
65,290
64,674

640*350
720*400
640*480
640*480
640*480
800*600
800*600
800*600
1024*768
1024*768
1280*1024
1280*1024
1440*900
1440*900
1440*900
1920*1080
1680*1050
1680*1050

70,086
70,087
59,940
67,000
75,000
56,250
60,317
75,000
60,004
75,029
60,020
75,025
59,901
59,887
74,984
60,000
60,000
60,000

TILBAGE TIL TOPPEN

(reducer blink)

Automatisk energispare

Hvis der er installeret et VESA DPM overholdende skaermkort eller software pd pc'en, kan skeermen automatisk
nedseette strgmforbruget, nar den ikke bruges. Nar input fra tastatur, mus eller anden input-enhed registreres,
"vagner" skaermen automatisk igen. Nedenstdende tabel viser denne automatiske energisparefunktions strgmforbrug

og signalering:

Energispare-definition
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VESA tilstand Video V synk L synk Forbrugt stram | Diodefarve
_ <24 W (typ.) )
Aktiv TiL Ja Ja < 30 W (maks.) Hvid
_ ] ) Hvid
Sovetilstand FRA Nej Nej <0,5 W (norm.) (blinker)




Produktinformation

Kontakt Fra FRA - - <0,5W (norm.) Fra |

This monitor is ENERGY STAR® compliant. As an ENERGY STAR® Partner, we have
determined that this product meets the ENERGY STAR® guidelines for energy efficiency.

* Disse data kan eéendres uden meddelelse derom.

Skaermens native oplgsning er 1680 x 1050. Som standard har skeermen 100% (maks.) 50% kontrast og
6500K farvetemperatur med fuldt, hvidt mgnster og uden lyd/USB.

TILBAGE TIL TOPPEN

Produktoversigter
Falg leddene for at se forskellige billeder med skeermen og dens komponenenter.

Set forfra - produktbeskrivelse

TILBAGE TIL TOPPEN

Fysisk funktion

Vip
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Produktinformation

20°

Kuglehoved

Hgjdeindstilling
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Kantelen (225P1)

Y

90°

v

D)

TILBAGE TIL TOPPEN
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Philips regler ved pixeldefekter

Produktfunktioner

Tekniske specifikationer

Oplgsning & Forudindstillede
tilstande
Automatisk energibesparelse

Fysisk specifikation

Pin-tildeling

Produktvisninger

Philips regler ved pixeldefekter

Philips' regler ved pixeldefekter pa fladskaerme

Philips tilstraeber at levere produkter af den hgjeste kvalitet. Vi anvender nogle af branchens mest
avancerede produktionsprocesser og udfgrer en streng kvalitetskontrol. En gang imellem er defekte pixler
eller sub-pixler pd TFT LCD-skeerme dog uundgaelige. Ingen producent kan garantere, at alle paneler vil
veere fri for pixeldefekter, men Philips garanterer, at enhver skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien. Dette notat forklarer de forskellige former for pixeldefekter og
definerer de acceptable defektniveauer for hver type. For at veaere berettiget til reparation eller udskiftning
under garantien skal antallet af pixeldefekter pa en TFT LCD- fladskeerm overskride disse acceptable
niveauer. For eksempel ma hgjst 0,0004% af sub-pixlerne pa en 19" XGA-skaerm veere defekte. Desuden
seetter Philips endnu hgjere kvalitetsnormer for visse typer eller kombinationer af pixeldefekter, derer mere
generende end andre. Denne pixelpolitik geelder i hele verden.

subpixel  subpixel  subpixel

N v ¥

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af tre sub-pixler med primeerfarverne rgd, grgn og bla. Nar
mange pixler saettes sammen, kan de danne et billede. Nar alle sub-pixler i en pixel lyser, fremstar de
farvede sub-pixler tilsammen som enkelt hvid pixel. Hvis de alle er marke, fremstar de tre farvede sub-
pixler tiisammen som en enkelt sort pixel. Andre kombinationer af oplyste og marke sub-pixler fremstar
som enkelte pixler i andre farver.

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa skeermen pa forskellige mader. Der er to kategorier af
pixeldefekter og flere typer sub-pixeldefekter i hver kategori.

Bright Dot Defects (Defekte lyse prikker) Defekte lyse prikker fremkommer som pixels eller underpixels,
der altid lyser eller er "pa". Det vil sige, at en lys prik er en underpixel, der fremstar pa skeermbilledet, nar
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Philips regler ved pixeldefekter

skaermen viser et mgrkt mgnster. Der er fglgende typer defekte lyse prikker:

To sammenliggende taendte sub-pixler:

. - Regd + Bla = Lilla .
En teend rad, gren eller bla - Rad + Gran = Gul Tre sammenliggende teendte

sub-pixel - Gran + BI& = Cyan (Lysebla) pixler (en hvid pixel)

En rad eller bla lys prik skal veere mere end 50 procent lysere end de omkringliggende
prikker, mens en gran lys prik er 30 procent lysere end de omkringliggende prikker.

Black Dot Defects (Defekte marke prikker) Defekte marke prikker fremkommer som pixels eller
underpixels, der altid er marke eller “fra". Det vil sige, at en merk prik er en underpixel, der fremstar pa
skeermbilledet, nar skaermen viser et lyst mgnster. Der er fglgende typer defekte marke prikker:

En mark sub-pixel To eller tre sammenliggende mgrke sub-pixler

Teetliggende pixeldefekter

Da pixel- og sub-pixeldefekter af samme type, der ligger teet pa hinanden, kan vaere mere igjnefaldende,
specificerer Philips ogsa tolerancer for taetliggende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller udskiftning pa grund af pixeldefekter i garantiperioden skal et TFT
LCD-panel i en Philips fladskeerm have pixel- eller sub-pixeldefekter, der overskrider de tolerancer, der er
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gengivet i falgende tabeller.

MODEL 225P1/225B1
1 teendt sub-pixel 3

2 sammenliggende teendte sub-pixler 1

Tre sammenliggende teendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

MODEL 225P1/225B1
1 mark sub-pixel 5 eller feerre
2 sammenliggende mgrke sub-pixler 2 eller feerre
3 sammenliggende mgrke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre

SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU

MODEL 225P1/225B1
Samlede bright- eller black dot-defekter af alle typer 5 eller feerre
Bemeerk:

*1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
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TILBAGE TIL TOPPEN AF SIDEN

file:///P|/P_TranslateFile/CC9/2009/7/CC9005153-Qisda-Philips%20225P1%20EDFU/OK/0715/DANISH/225B1 /product/pixel.htm &5 4 B / 3£ 4 [2009/7/15 T 03:42:57]




Smart-Kontrol

Smart-Kontrol Il (Udvalgte Modeller)

Produktinformation

Philips's politik vedrgrende
defekte pixler

Philips Smart-Kontrol Il

Philips Smart-Kontrol Il

Systemstgtte og -krav Smart-Kontrol Il er et skeermbaseret software med en letanvendelig skaerm-grafisk greenseflade, som leder dig gennem
finindstilling, oplgsning, farvekalibrering og andre skaermindstillinger, herunder lysstyrke, klokke & fase, position, RGB,

Installation hvidpunkt og - for modeller med indbyggede hgijtalere - lydstyrke.

Begynd at bruge

Systemstgtte og -krav
Spargsmal&Svar

1. Sytemstgtte: 2000, XP, NT 4.0, XP 64 Edition, Vista 32/64. IE Support 6.0/7.0.
2. Sprog: Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk og portugisisk.
3. Philips skeermstegtte DDC/CI graenseflade.

Installation:

2

SmartCankrol 1T
Installer, e

SmartControl |l
Welcome to the InstallShielf Wizard for SmartControl

The Wizard will ingt 2ll SmartControl onyour compuber. To conkinue, dick Nest.

PHILIPS

| we> | [ Easew |
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Smart-Kontrol

e Folg instruktionen og fuldfar installationen.
e Du kan starte, nar installationen er fuldfart.

e Hvis du vil begynde senere, kan du klikke pa genvejen pa skrivebordet eller pa vaerktgijslinjen.
Begynd at bruge

1. Farste start - Guide

Farste gang efter installationen af Smart-Kontrol Il g& den automatisk til guiden ved fgrstegangsstart.
Guiden leder dig trin for trin gennem indstilling af skeermen.

Du kan ogsa ga til Plug-in menuen for at starte guiden pa et senere tidspunkt.

| Standard-ruden kan du indstille flere funktioner uden guide.

’ Oplasning | Oplasning
’ Fokus | Kontrast
] Lysstyrke | Lysstyrke
] Kontrast | Hvidtpunkt (farvetemp.)
y Position | Fil
’ Hvidtpunkt (farvetemp.) |
] Fil |
[T Smart Control I E3
Smart Contral |l PHILIPS
Ad)ET J colsr J PLIgE | Prasats J Optiang ] Mgy

() Wizard

Yoourl naad to calbrate wour dipley to get the most acourate oakos, Y enooura0e you ho use the Smpie buring
pracess by seledting the Scast Wizard button. This process irvolved & senes of steps that will k2 you bune your
display and s the soltings.

L. Choose the Start Wisad butten.
2. Follow the steps oublired i this process.
3. ShE yoUr SelBRgs far Rbufe usk

Shark Wizerd

2. Start med Standard-rude:

Adjust menu (Indstillingsmenu):
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Smart-Kontrol

o Med "Adjust" ("Indstilling"-)menuen kan du indstille Brightness (Lysstyrke), Contrast (Kontrast), Focus (Fokus), Position

(Position) og Resolution (Oplgsning).
e Foretag indstillingen ved at falge instruktionerne.
e Installationen kan annulleres med Cancel (Annuller).

Fanebladsoverskrift Skeerm i Analog Skeerm i Digital
Ja Ja

’ Indstil ’ Lysstyrke | |
’ Indstil ’ Kontrast | Ja | Ja
] Indstil ] Fokus (Klokke & Klokke Fase) | Ja | Nej
] Indstil ] Position | Ja | Nej
] Indstil ] Oplgsning | Ja | Ja

| Smart Contral Il @

Smart Contral |l PHILIPS

AdLEr . Color _ pgre | mosats | Optin Heip |
Brighitriess 1]

Brightness

Inproperty adjusted Brightness vill resUit I 4 loss of detal n darker Mage: areas. Adiust the Brightness
fie the best pesshle piture quality,

1., Lise the Pattenn buton 1o bring up the adjusireent insge.
2, Lorer the Brightness wntil e daik shrioes berd oot
4. Elowdy ralsa the Brightness untl eadh of tha dark siripes bacome viakle.
Try b schise bn equal censrstion. The darkecr dhen id S reman Hade

OO 1]

vl *) *)
|
‘_ = I_____h.j L;-_—:—_'J—%h. J = J
unde | [ messe ]
|7-] SmartControl i =
SmartControl |l PHILIPS
st Color J Plugins J Presats ] Cptions Help J
EI Contrast Cordrast o
Aufpst the Contrast fuse the shder) to keep detal: N bghber mage aeas. DLED
1. Ligs the FACST battion 16 ng up L Sdltment mage,
&, Rt e Cordrast urddl B rarabers | arvd 2 aee nd ionger vidbin,
3, Scwaly lowser (the Conbract bo maks the numbers 2 and 5 resppear: The rumbes | shoukd remasin barsly vicble.
o, =4 )
2 Fettorn
urds ][ Reset
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Smart-Kontrol

SmartControl |

pat ) o | Pem )

Pesats | optors | Helo J

PHILIPS

Focus

o dhoplyy's biming readis o b cyncheonized withthe video signal.
1. Lise the Pattem button bo bring up the sdiestment image.

2. Choose Ao Sstup.

3. I the vertical bands are il vishie, youll need to adiust the Frch.

Piteh: Try to rashe the verticd bareds doappear

Phase: Adiust b the beightest setling ba minmise
meovemend on the streen.

DC?FZB
O O — )

o x E
111 e
[ b | [ asosenw |
SmartContral I PHILIPS
mw Lokt ] Plugng J Prsats J Opriors ] Help "
Pasition
Lics the Position buttons o center the imisgs o yous deiplry. Lising this too, you can potion the megs U, dowr, ()
B = =
1. U s Pusitiers bukibon £ bring up the adiustinart imsgs 3
2. LEa U UnDowe Buttang Lo Chbir tha mRage vaitically,
3. Livethe Laft/Right buttons to center the mage barizortaly. B
——a,
w b4 kS
[ e ] [ Rpst ]
SmartControl Il PHILIPS
o adst Jl o [ Pugrs [ cotiors l et [ presets
Resolution
You arm curnenthy ot a Preferred resolution, For your deolay b shove ™ Enable Resclution boifier
erisg, dhoar berek, cokrs, and imeges, your diplay sheukd be set bo ks e
¥ your disploy ks at frrred reshiion, dck on the Pref
button to changs your neschubion to Preferred.
- - x
=

Farvemenu:
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Smart-Kontrol

Med "Color" ("Farve"-)menuen kan du indstille RGB, Black Level (Sortniveau), White Point
(Hvidpunkt), foretage kalibrering og Smart-Billede (se afsnittet Smart-Billede).

Foretag indstillingen ved at falge instruktionerne.

Se nedenstdende oversigt med undermenupunkter baseret pa dit input.

Eksempel pa farvekalibrering

Fanebladsoverskrift Skeerm i Analog Skeerm i Digital
Ja Ja

Farve RGB

| | | |

’ Farve ’ Sortniveau ’ Ja ’ Ja
] Farve ] Hvidpunkt ] Ja ] Ja
| | | |
| | | |

Farve Ja

Ja

Farvekalibrering Ja

Farve Visningstilstand Ja

I Smart Control Il T —— X

Smart Contral |l PHILIPS

ALt ;5 Color | PLgine fragats j Cptiors | Hiip |

@ RCE Red 0
Al dsnlaved colors are producad by mi<ea Red, Blus and Green at dfferent brightness levels. Choceing & newtral D m IEI

Yhibe: Poink will give you tpkinal RiGE. IF rou prefer ba adpst the REE nowy, Fobes thess steps:

1., Lise the Pattenn butdon o bring up the adjusireent insge.
2, Ppurst the irtoroky of the Fed, Groon and Blue using the slider bars,

nale! Charging the RGE values can aduercel: sffice the dieplayved colors.

(

| smartControl Ii B

SmartContrel |l PHILIPS
Adpust J oot J Plugrs J Presets J Options J Help

(@] White Peint

White Pank
White Poing is the poink st which equal combinations of red, green and bles light o2 full interaity croate white, TThis I:IE.: IE‘
affects the cwerall color quality, For ithe most acourate colors click the Reset button then select the Whibe Frint. Liser

1. Uiee thes Patterns buttee b bring up thee scdhastimest image.
1. Helding a peoe of white paper noxt ko the daplay, choose the White Foint value that makes the dapley matich
e white: paper.

v/

{x
W
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Smart-Kontrol

ﬁ

SmartControl Il PHILIPS
[ adist oo coor  J[ Pors [ opios [ Heb [ Presats

E Gamma Garnna 22
e i & compront of th phol brightress in a depliy. A lower Gamma valus produces brighber pools and & DD—

Tichar Gormna vokes produces darker piosli. Nermal cofrgater doplays Lse & Gamina vahse of 2.2,
To adiusk Garmma, Seartlmace has bo be off, Click the “SmartImage D" butten before adjusting Gamersa.

1. Uae the Pattern butten bo brng up the sdiustment mmages.
2, U the ghdder ke seioct the desired Ganna.

Smart Control Il PHILIPS

At || toor  J|  Pgne ]| Pessts || optons || b |

[=#) Color Calibration

Your dsplay needs ¢ be properky calbrated in crder For & bo produce the widest range of colors: scourstely,
Callbration shoukd shirys baks place a the lsst buning stepin the process, Remenber bo recalbeate anvy lins you
ks incvidesl adiustments to imege quality or wherever youmove your display bo a ness leoation,

1, Maka 5 Othir fbcadsany adjastmants 1o mage Gualty First .
2 Prive Shosy Ma'to i Bosw 15 uie th Callr staon todle,
3. Finaly, prees Start to bagin the calitrabion procese.

¥ Enais Celor Callrations

Color seftware designed in collabor stion with Joseph Holmes .
Protectnd by UL 5. Patent Mo. 6,586,553

. "Show Me" ("Vis Mig") starter vejledningen i farvekalibrering.

. "Start" - starter 6-trins farvekalibrerings-sekvensen.

. "Quick View" ("Quick-visning") indleeser far/efter-billederne.

. For at vende tilbage til "Color" ("Farve"-)startruden, skal du klikke pa "Cancel" ("Annuller").

. Aktiver farvekalibrering - der som standard er aktiveret. Hvis markeringen er fiernet, kan der ikke ske
farvekalibrering, ligesom start- og quick-visning knapperne er gratonede.

. Der skal veere patent-oplysninger pa kalibreringsskaermen.

Ol WD+

D

Forst farvekalibreringsskaerm:
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Smart-Kontrol

"Previous" ("Foregaende"-) knap er deaktiveret, indtil den anden farveskaerm.
"Next" ("Naeste") gar til efterfalgende mal (seks mal).

"Final next" ("Afsluttende Naeste) gar til File > Presets (File > Forvalg) rude.
"Cancel" ("Annuller") lukker Ul og vender tilbage til "plug in"-) siden.

=W

Smart-Billede - tillader brugeren at eendre indstillingen for at opna en bedre skeermindstilling baseret pa indhold.

Nar der indstilles pa "Entertainment” ("Underholdning"), aktiveres Smart-Kontrast og Smart-Svar.

SmartControl 1 PHILIPS

[ st | cok | Pugns | Presets | cotors | He ]

) smartimage

Smartimage prowides diferant brightness and contmst levels to accomodate today's wide range of computer

JpphaTonL.

Chonse thi settng that i mast comforrabile ar efficent when wewing your applcation. Atematiel, smoly

choose the ene that best descrbed i type.

O U U o

Office Image Viewng  Enteriamment Ecanommy E

[erage viewng |
ENtertanTIRNG

Plug-Ins - "Asset Management" ruden er kun aktiv, nar "Asset Management" er valgt i Plug Ins-rullemenuen.
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Smart-Kontrol

W

SmartControl |l PHILIPS
Adjust ] Color J o Pugns | Options ] | Help ] Presets ]
Asset Management
HMamstacturer Current Timing
Phips Beckronics TO24TEOBED He
CHESCFip by Dvmain Name
PHMEIZA%R PORTRALT
Serial Humber Camputer Hame
B4 GHAS Alohmon
Aswel Management Statee

Viser "Asset Management" oplysninger vedrgrende styring, beskrivelse, serienummer, nuveerende timing,
domaenenavn samt "Asset Management" status.

Veelg plug-in-fanebladet for at vende tilbage til Plug-in startsiden.

Plug-Ins - "Theft Deterence" ("Anti-tyveri") ruden er kun aktiv, nar "Theft" (“Tyveri") er valgt i Plug Ins-rullemenuen.

& SmariControl |

SmartControl Il PHILIPS
adst | o || Peows J  oowons || nee | mees |

.Theftl:leterrate

Mmmummmlmwmhmwm To Enabla Thaft

Doterroncs, chck cn Enabla Thatt. Arst-time Lsers wil requine 3 Parsanal Identification hurbier (PIN). If tha

display is remaoved from this comgputer, this PINis needed to suthorice use on srother computer. Theft Detararce Diated

For at aktivere "Theft Deterrence”, skal du klikke pa "Aktiver Tyveri", hvorefter falgende skaerm ses:
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Smart-Kontrol

A SenartConlrol Il

SmartControl |l PHILIPS
Adpst J Color | Plug-ns J Opitions J Hely J Presats |

|®] Theft Deterrence Tew et dpiw RO

Thiaft Detoirercs & cunently Disabled. To anable Thaft Deterrencs, antar your PIN in e Bowx Balow, than [_] _] i_]

chck: ACCeRE, = &

Enter PN to enabls Thift Detemenca:

Reerter PIN IDM!}'I

Der kan kun indtastes en PIN-kode pa fra fire til ni cifre.

Nar PIN-koden er indtastet, leder "Accept" ("Accept"-) knappen brugeren til pop-op dialogboksen pa fglgende side.
Minimum-minutter er fem. Skyderen star som standard pa 5.

Kreever ikke, at skeermen forbindes til en anden veert for at g& i anti-tyveri tilstand.

=W

Nar en PIN-kode er indtastet og accepteret, ses fglgende dialogboks:

M SmariConltrol Il r:A'|
H2i
SmartControl Il ?

Register your PIN onlne (requires connection to the internet)

PHILIPS L__ves No J

e Etklik pa "No" ("Nej") leder brugeren til den falgende skaerm.

& SmartCantrel I

SmartControl |l PHILIPS
At | ok [ YT, — optons | Helg J Fresats |

E] Theft Deterrence

Thiaft Detmance protects your dispiay agarst unauthozed removal #iom Your computer. To Diable Thift
Cetarence, did: on Desable Theft. Frst-time users will reguine a Persond Identification Number (FIM). If the
dsplay s removed from this computer, this PN i needed to sUthone e on anothes computer. Theft Deterance Enabled
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Smart-Kontrol

e Etklik pa "Yes" ("Ja") leder brugeren til sikkert websted landingpage.

Nar der er oprettet en PIN-kode, indikerer "Theft Deterrence" ruden, at "Theft Deterrence" er aktiveret og giver
PIN-kode funktionsknap:

& SmariCantrel Il

SmartControl |l PHILIPS
At J Cokr J Fhugns Options J Heip J Frasats J
E] Theft Daterrence
Theft Detemance protects your diglay agenst unauthonized removal om your computer. To Diable Thett
Cetemence, didk on Disable Thaft. Frst-time usess will require a Personal Identification Humber (PIN). If the:
display is removed from this computer, this PIM is neseded to authcorine use on anothes compuber, Thwft Deterance Enabled
Diabie Theft

1. "Theft Deterrence Enabled" ("Anti-tyver Aktiveret") ses.
2. Deaktivering af "Theft" &bner rudeskeermen pa naeste side.
3. PIN-kode Funktioner knappen virker kun, nar brugeren har oprettet PIN-kode. Knappen abner sikkert PIN-kode websted.

Deaktivering af "Theft" knappen abner fglgende rude:

B SmariControl 11 El
SmartControl I PHILIPS
Adist J Cakor Pilig-rs | Options ] Help J Frasals

@ Theft Deterrence

Thaft Dotemance & ourrenty Enabled. To dicsbie Theft Detemence, entsr your PN in th bax beioe, than
cick Accept.

Erter PIN to disable Theft Detemence:

[ Aceot [ comesl |

1. Nar PIN-kode er indtastet, deaktiverer "Accept” ("Accept'-)knappen PIN-kode.

2. "Cancel" ("Annuller"-) knappen abner hoved "Theft Deterrence" ruden og viser "Theft Deterrence Disabled") ("Antityveri
Deaktiveret"). Aktiver "Theft" og PIN-kode Funktioner knapperne.

3. Forkert indtastning af PIN-kode medferer falgende dialogboks:
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Smart-Kontrol

. SmariConltrel I

et Laterrence Eror

SmartControl || !
Falled to dsable theft deterrence!
Please reenter the PIN and try agan,

PHILIPS o)

"Options > Preferences" ("Funktioner > Indstillinger") - er kun aktiv, nar Preferences (Indstillinger) er valgt
i Funktioner-rullemenuen. Pa en ikke-understattet skeerm med DDC/Ci er kun "Help" ("Hjeelp")
og "Options" ("Funktioner") til rdighed.

SmartContral I PHILIPS
Actjust Coloe Phugins | Options | Hep Pre-sets

E] Prefarerices LED Erightriess 0

Yioud can aise the Tolowang options bo configune Smar Contsol 1T [mprorred enterbainment: —] _ [—]

' Enable nenu when right-dicking on deskiop I~ Enabls SmastResponss

W Enable task. tray men I Endbie SmartCorkrast

M Run sk syskam shart-ug

Sat WarGpar iy
0% & S0% & 100%

Salst Languags

Erciish o

W DN —

6.

. Viser nuveerende, foretrukne indstillinger.
. Funktionen aktiveres ved at afmaerke feltet. Afmaerkningsfeltet er en flip-flop.
. "Enable Context" ("Aktiver Indhold"-) menuen er som standard afmaerket (Til) pa skrivebordet. "Enable Context"

menuen viser Smart-Kontrol Il valg til "Select Preset" ("Veelg Forvalg") og "Tune Display" ("Indstil Display") p&
hgjreklik indholdsmenuen pa skrivebordet. "Disabled" ("Deaktiveret") fierner Smart-Kontrol Il i hgjre-klik indholdsmenuen.

. "Enable Context" ("Aktiver Indhold"-) menuen er som standard afmeerket (Til) pa skrivebordet. "Enable Context" ("Aktiver

Indhold") menuen viser jobbakkemenuen for SmartKontrol Il. Et hgjreklik pa jobbakke-ikonen viser menufunktionerne for
"Help" ("Hjeelp") og "Technical Support" ("Teknisk Statte"). Afmaerk for "Upgrade" ("Opgradering"), "About" ("Om")

og "Exit" ("Afslut"). Nar "Enable Task Tray" ("Aktiver Jobbakke") menuen er deaktiveret, viser jobbakke-ikonen kun EXIT
(AFSLUT).

"Run at Startup” ("Kar ved Startop”) er som standard afmaerket (Til). Nar den er deaktiveret, starter Smart-Kontrol ikke ved
starten eller er ikke i jobbakken. Smart-Kontrol Il kan kun startes fra genvejen pa skrivebordet eller i programfilen.

Intet forvalg, indstillet til at kare ved startop, indleeses, nér denne boks ikke er afmaerket (er deaktiveret).

Aktiver gennemsigtigheds-tilstand (kun Vista, XP og 2k). Standard er 0% uigennemsigtighed.

"Options > Input” ("Funktioner > Indgang") - er kun aktiv, nar "Input" ("Indgang") er valgt i
"Options" ("Funktioner"-)rullemenuen. Pa en ikke-understgttet skeerm med DDC/Ci er kun "Help" ("Hjzelp")
og "Options" ("Funktioner") til radighed. Alle andre Smart-Kontrol Il faneblade er ikke til radighed.
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M

SmartControl I PHILIPS

agust )| cdee ) Pugns [ Pessts  J[ opmes ] Hee |

. Input
Your displry has two inputs (connections on back of this disoly) so you can hook up two diferent sources at

the mme tima. Usa the Analeg In and Digital In buttens te select which sowrce you'd ke to view, You are
cumently vMawng tha Digital In maga.

THPORTANTI F you switch inputs SmertControd I may bee the abity to centrol your montor, In this case you
ey have to use the Input Salect bution on tha front of your monkor to swich badk o tha original input
beefore SmatControl Il functionsity can be restoned.

[ amaogn  J[ ogemn ][ ograiem |

1. Vis "Source" ("Kilde") instruktionsruden og nuvaerende indgangskilde indstilling.
2. Ved enkeltindgangsskaerme ses denne rude ikke.

"Options > Audio" ("Funktioner > Lyd") - er kun aktiv, nar "Volume" ("Lydstyrke") er valgt i

"Options" ("Funktioner"-)rullemenuen.
Pa en ikke-understattet skaerm med DDC/Ci er kun "Help" ("Hjzelp") og "Options" ("Funktioner") til radighed.

M

Smart Control Il PHILIPS
Adust | Coor | pgns | Pressts || Options ] W |

Audio Voo o

fudimt e vume of U inbegr atedd loudson shers Ly iy the dider D_

Turr: eff the integrated udipsskans by chacking the Muts chisckbon.

F Mute

"Option > Auto Pivot" ("Funktion > Auto Pivot")
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SmartControl || PHILIPS
s (e pone (v (sl ( prets

(2] Aute Pivot

mmmmu&wmuaww Unchack the Auts PROE Box £0 dEabla JUTOMATE

Sreen-mags rotation

¥ Enibla Auto Pivot.

i)

"Help > User Manual" ("Hjeelp > Brugervejledning") - er kun aktiv, nar "User Manual" ("Brugervejledning") er valgt
i "Help" ("Hjeelp"-)rullemenuen. P4 en ikke-understgttet skaerm med DDC/Ci er kun "Help" ("Hjeelp")

og "Options" ("Funktioner") til rddighed.

Smart Control PHILIPS
[ mdws ]| col J ruges | presers | opors | | Heb ]
Uaarl""larlual

IF oo rebeed b atting up or opserating Display Ture, clek Tochnical Support | Youllhavs the option ta il auk an

Acgctance Form.

‘b pan dsn choose to heve information sbout your softveare sutomatically stteched (o the swsistance Form. Youll
resad to be online b uss this festure.

I

"Options > Version" ("Funktioner > Version") - er kun aktiv, nar "Version" ("Version") er valgt i
"Help" ("Hjeelp"-)rullemenuen. P& en ikke-understgttet skaerm med DDC/Ci er kun "Help" ("Hjeelp")
og "Options" ("Funktioner") til rddighed.
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ﬁ

Smart Control Il PHILIPS
st Color ] Pugrs | Fresets | options | | Help d

5] Version

Csplay

Tune
Wersion 3.20 dtune-sterdard-RI00T-01 -0+ 1 150-23

Copyright 1993-2007 Postrat Display, Tnc.
DONCT Comeunication: ASIC

Context Sensitive (Indholdssensitiv) menu

"Context Sensitive" menuen er som standard aktiveret. Hvis "Enable Context" ("Aktiver Indholdssensitiv") menuen
er afmeerket i "Options > Preferences" ("Funktioner > Indstillinger") ruden, ses menuen.

Arrange [cons By 3
Refrech

Paste
Paste Shortcuk

New 3

Properties

SmartControl Il

Selact Presst >

Tume Display

Smarthnage Oft
Office Work

v Image Viewing

Ertertzainment
Ecaonomy

"Context" menuen har fire punkter

1. Smart-Kontrol Il - nar valgt, ses "About" ("Om") skaermen.

2. "Select Preset” ("Veelg Forvalgt") - en hierakisk menu med gemte forvalg, der straks kan bruges. En afkrydsniong viser det i
gjeblikket valgte forvalg. "Factory Preset" ("Fabriksforvalg") kan ogsa hentes i rullemenuen.

3. "Tune Display" ("Indstil Skaerm") - &bner Smart-Kontrol II's kontrolpanel.

4. "Fly off for Smart-Billede" - tiek nuveerende indstillinger: "Off" ("Fra"), "Office Work" ("Kontorarbejde"),
"Entertainment" ("Underholdning") og "Economy" ("@konomi"

"Task Tray" ("Jobbakke"-) menu aktiveret

file:///P|/P_TranslateFile/CC9/2009/7/CC9005153-Qisda-Philips%20225P1%20EDF U/OK/0715/DANISH/225B1 /product/SMART HTM # 14 B / £ 17 [2009/7/15 T4~ 03:43:11]



Smart-Kontrol

"Task tray" menuen kan ses ved at hgjreklikke pa Smart-Kontrol Il ikonen i opgavebakken. Et venstreklik starter programmet.

Help

Technical Support
Check for Update
About

Exit

Jobbakken har fem punkter:

. "Help" ("Hjeelp") - adgang til brugervejledning-fil: Abner Brugervejledning-fil med standardbrowservinduet.

. "Technical Support" ("Teknisk Hjeelp") - viser siden med teknisk hjaelp.

. "Check for Update " ("Tjek for opdateringer”) - leder brugeren til PDI Landing og tiekker brugerens version i forhold til den
allernyeste version.

. "About" ("Om") - viser detaljerede referenceoplysninger: Produktversion, frigivelses-information og produktnavn.

. "Exit" ("Afslut") - luk Smart-Kontrol Il. For at kare Smart-Kontro Il igen, skal du enten veelge Smart-Kontrol Il i
"Program” ("Program”-)menuen, dobbeltklikke pa skrivebordet eller genstarte systemet.

W DN —

SIS

PHILIPS

SmartCo

SmartControl
“ersion 3.20
chune-standard-R2007-01-04-1151-23
Copreright 1983-2007 Portrait Displaye, Inc.
Patents Pending

"Task Tray" ("Jobbakke"-)menu deaktiveret

Nar "Task Tray" ("Jobbakke") er deaktiveret i indstillinger-mappen, er kun valg af "EXIT" ("AFSLUT") til rAdighed. For helt
at fierne Smart-Kontro Il fra jobbakken, skal du deaktivere "Run at Startup" ("Ker ved Startop") i "Options
> Preferences" ("Muligheder > Indstillinger").
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Smart-Kontrol

Spgrgsmal&Svar

SP1.Jeg udskiftede pc-skaermen til en anden, og Smart-Kontrol virker ikke mere. Hvad skal jeg ggre?
SV. Genstart pc'en og se, om Smart-Kontrol virker. Hvis ikke, skal du fijerne og geninstallere Smart-Kontrol for at sikre, at
den rigtige driver er installeret.

Q2.Smart-Kontrol virkede godt i begyndelsen, men ikke nu. Hvad skal jeg gore?
A. Hvis nogle af de fglgende handlinger har vaeret udfert, skal skaermdriveren maske geninstalleres.

Videografikadapter er blevet udskiftet med en anden

Opdater videodriver

Aktiviteter i OS som f.eks. servicepakke eller programrettelse
Opdater Windows og opdater skaerm- og/eller videodriver
Windows blev startet med skeermens strem slaet fra eller afbrudt.

For at finde ud af det, skal du klikke p& "Denne Computer" og derefter p4 Egenskaber -> Hardware ->Enhedsstyrer.
Hvis du ser "Plug & Play skaerm" under Skaerm, skal du geninstallere. Fjern ganske enkelt Smart-Kontrol og geninstaller det.

SP3.Efter installation af SmartKontrol og tryk pd Smart-Kontrol fanebladet sker der intet, eller en fejimeddelelse dukker
op. Hvad er der sket?

SV.Grafikkortet er muligvis ikke kompatibelt med Smart-Kontrol. Hvis grafikadapteren er en af ovennaevnte maerker, skal
du prave at downloade den mest opdaterede grafikadapterdriver fra det pAgeeldende firmas ? websted. Installer
driveren. Fjern Smart-Kontrol og installer det engang til.

Hvis det stadig ikke virker, er vi bange for, at grafikadapteren ikke understgattes. Ga til Philips? websted for at se, om
der findes en opdateret Smart-kontrol driver.

SP4.Nar jeg klikker pa "Product Information” ("Produktinformation”), ses kun nogle af oplysningerne. Hvad er der sket?

A.Det kan veere, at din grafikkortadapterdriver ikke er den mest opdaterede version, som fuldt ud understatter DCC/
Cl greenseflade. Prgv at downloade den mest opdaterede grafikkortadapterdriver fra det pageeldende firmas ?
websted. Installer driveren. Fjern Smart-Kontrol og installer det engang til.

ATTENTION

SP5.Jeg har glemt min PIN-kode til anti-tyveri funktionen. Hvad ger jeg?

SV. Kontakt IT manager eller Philips Servicecenter.

SP.6 Pa en skaerm med Smart-Billede funktion reagerer SRGB farvetemperaturfunktionen i Smart-Kontrol ikke. Hvorfor?

SV. Nar Smart-billede er aktiveret, deaktiveres SRGB systemet automatisk. For at bruge sRGB skal du deaktivere

Smart-billede med @7 foran p& skeermen.
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Smart-Kontrol

TILBAGE TIL TOPPEN
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